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Introduction

Superlogic Pro is a graphical and feature-rich ladder-logic programming environment for
the Smart3G cards that is developed to meet industrial programming standards for many
specialized applications. Operation-wise, the SuperlL.ogicPro application also serves

as the direct interface to the connected Smart3G card.

Features:

e Create robust, powerful, and reusable ladder-logic programs
and download them to cards

e Upload and Modify existing ladder-logic programs straight from a Smart3G card
e Monitor and debug program execution during runtime
e Temporarily change Ladder Files contents while monitoring without altering rungs

e Drag-and-drop Graphical User Interface for simple,
yet extensive ladder-logic programming

REV A SuperLogic Pro - User & Troubleshooting Guide
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Menu Bar Overview

T DA T ROER X o8k <AlPogams> ~ b B o MR
1 2 3 45 6 7 8 9 10 1112 13 14 15 16 1718 19 20
1. Create New Project 11. View Device Status
2. Open Existing Project 12. Install Current Project on Device
3. Save Project 13. Upload Project from Device
4. View Project Explorer 14. Ladder Program Selector (Affects 14 —19)
5. View Toolbox 15. Run Selected Ladder Program on Device
6. View Property Window 16. Stop Selected Ladder Program on Device
7. View Debug Window 17. Reload Selected Ladder Program on Device
8. View Output Window 18. Monitor Selected Ladder from Device
9. Find 19. Configure Selected Device
10. Connect to Device 20. View Cross Reference

REV A SuperLogic Pro - User & Troubleshooting Guide 2.1
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Ladder Editor

Ladder Program: burnin

Find
Copy
Paste
Delete

Ladder Description
Ladder Properties

Smart3G

The Ladder Editor is where ladder programs are edited and monitored. This window can be
accessed by Double-Clicking a ladder program node under “Ladder Programs” in the Project
Explorer, or by creating a new Ladder Program.

To create a new Ladder Program:

—h

Right-Click on the “Ladder Programs” node in the Project Explorer

2 Select “Add New”

3 Input a valid Ladder Program Name (this can be changed later on)

4 Confirm

The Ladder Editor for a ladder program is also automatically opened when monitoring
is enabled from the Project Explorer, or the lcons Menu Bar.

Note: When modifying a contact, it can almost always be done from the Property Window.
It is also possible to copy and paste rungs and contacts between multiple Ladder Editors.

REV A SuperLogic Pro - User & Troubleshooting Guide 2.2
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Project Explorer Window

The Project Explorer Window is the basic navigation
and management window for the application. It can be
accessed from the View Menu or by clicking the Project
Explorer Icon under the Menu Bar.

The Project Explorer diplays:
e The current active project
e The Ladder Program on the active project
e The Ladder Subroutines on the active project

e The Tag Database for creating any form
of text definitions

e The Text Database where Smart3G serial barcodes
can be defined

Toolbox Window

The Tool Box contains the needed tools and actions
for creating a ladder program. Adding contacts, rungs,
or branches, etc. can be done from here.

The Tool Box can be accessed from the View Menu,
or by clicking the Tool Box Icon under the Menu Bar.

For a list of available commands,
see Ladder Commands (Chaper 4).

REV A SuperLogic Pro - User & Troubleshooting Guide
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Project Explorer 1 x

=-__| burnin

- __| Ladder Programs

= [E] burnin
= @ mySub

@ subA
® subB
—}-_| Subroutine Templates
mySub
0 Tag Dictionary
=@l Barcode Database
LQ Destination1
|_q] Destination2

Toolbox ﬂxr

Input Contacts

<k NO Contact

2 NC Contact

22 Compare

Output Contacts
< Output

Timer /Counter

f=f Move

£ Send Message

HH math

RS Reset

IE Ladder Subroutine
Rung

k| Insert Rung Above
k0| Insert Rung Below
== Insert Rung Branch
Smart 3G

4 Text Lookup
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Properties Window Properties ax
The Properties Window displays the properties iél
for each command in the Ladder Program Editor. 4 Command: Output
Address ouT:33
It can be accessed by Right-Clicking inside a Ladder ) a‘.‘:”“pe Latch
View and Selecting “Properties”, from the View Menu, S
or by clicking the Property Window Icon under Enabled True

the Menu Bar.

Note: Modification is disabled when the ladder program is being monitored.

Debug Window

} ERROR: Lookup contact must have a specified Lookup Target
ERROR: OUT:335 Smart3G Digital Outputs can only be numbered 1 - 72

ERROR: Parameter must have a value

The Debug Window displays compilation errors for the ladder program (if there are any)

after the compilation process. Error entries can be clicked to jump to the source of the error.
The Debug Window can be accessed by clicking the Debug Window Icon under the menu bar,
otherwise it pops-up when errors are detected after compiling a Ladder Program.

Output Window

Description
Opened: C:\Users\marc\Desktop\dev\LogicOn Projects\bumin ldr

Build Started "bumin" on (6/12/2015 11:51:41 AM)

Build Started “mySub” on (6/12/2015 11:51:41 AM)

"mySub"” Compile Success. Checksum:0

C:\Users\marc\AppData\Roaming\SuperLogic Pro\Smart 3G \program c: 1:0: waming: Compiler option forward propagate) ignored due to lite-mode limitations
C:\Users'\marc\AppData‘\Roaming\SuperLogic Pro\Smart 3G\program c: In function "LadderRun’

C:\Users\marc\AppData\Roaming\SuperLogic Pro\Smart 3G \program c: 79:2: waming: passing argument 1 of "Lookup String" from incompatible pointer type
C:\Users'\marc\AppData‘\Roaming\SuperLogic Pro\Smart 3G \program .c:79:2: note: expected ‘const char “ but argument is of type ‘const char * const™
C:\Users\marc\AppData\Roaming\SuperLogic Pro\Smart 3G\Smart 3G .c:1:0: waming: Compiler option forward propagate) ignored due to lite-mode limitations
Id: waming: cannot find entry symbol startup: not setting start address

"bumin" Compile Success. Checksum:3CC01

| CBBpu G Debug |

The Output Window provides detailed and technical feedback such as application
log messages, compile messages, and errors. The Output Window can be accessed
by clicking the Output Window Icon under the menu bar, otherwise it pops-up
automatically when necessary.

REV A SuperLogic Pro - User & Troubleshooting Guide 24
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Device Status Window

OUTPUTS _ : ES B ner

10 PWR
INPUTS

BN ReG [FLT [cw [cB | siaveto | cmF |

The Ladder Status window displays general information about the target device, as well as

its files. The current values may be viewed in this window if there is a connection is present.

The user may also change the file values from this window, which provides a degree
of manual control on the execution of the ladder program.

The Status Window can be accessed by clicking on the Status Window icon
under the menu bar.

REV A SuperLogic Pro - User & Troubleshooting Guide
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Tag Database Window

Comment

Default

BarcodeClearBit CB:10 Clears the cument scanned barcode
LookupOutput 1 OUT:33 Tums on when a scanned barcode was located in database 1

Tums on when a scanned barcode was located in database2
Add New Tag

Edit Tag
Delete Tag

SuperlLogic Pro supports user-defined tags that can be substituted in place of the standard
file addressing of the Ladder-Logic syntax. These definitions are created and modified in
the Tag Database Window. The Tag Database Window can be accessed by double-clicking
the “Tag Database” node in the Project Explorer.
Creating a tag has the following parameters:

e Name — The definition mask over the real value of the tag

e \Value — The real file address in correct Ladder-Logic syntax

e Comment
Advantages of using tags:

e More descriptive file addressing

e |f you are using a tag multiple times in the ladder program, you can simply change

the value in the Tag Database Editor once and it will affect all commands

using the tag

e Message Formats can be defined using tags

REV A SuperLogic Pro - User & Troubleshooting Guide 2.6
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Cross Reference

oss Referenc = |
Ladder Program: | [All Sources] v | File Type: v Refresh
File Type Files in Use
BIN 1.2.3.4,5.6.7
ouT 1.2.3.456,7.8
TMR | B
CB 10
REG 1
Address Rung Ladder Program &
BIN:5 Rung:3, Posttion:3, Level:2 bumin
BIN:5 Rung:4, Position:1, Level:4 bumin
BIN:6 Rung:3, Posttion:5, Level:3 bumin
BIN:6 Rung:4, Posttion:2, Level:3 bumin
BIN:7 Rung:4, Position:3, Level:1 bumin
CB:10 Rung:11, Posttion:6. Level:1 bumin
LookupQutput 1 Rung:9, Posttion:6, Level:1 bumin ~
LookupOutput2 Rung:10, Position:6, Level:1 bumin -
out:1 Rung:7, Posttion:6, Level:2 bumin
out:1 Rung:8, Posttion:1, Level:1 bumin
ouUTA Rung:1, Position:6, Level:1 bumin
ouTA Rung:2, Position:6, Level:1 bumin
ouTA Rung:3, Posttion:6, Level:1 bumin
OlIT-1 Riuna4 Pasttionf | evel-1 bt imin s
< m | »

The Cross Reference View provides a list of which Device Files and Defined Tags are
used in the current project. It also lists which rung and Ladder Program is referencing
the file, device, or tag.

REV A SuperLogic Pro - User & Troubleshooting Guide
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Signed 32-bit Integers

Signed 32-bit Floats (floating point value)

Bits (1 or 0)

Timers

Counters

Barcode text strings

Etc.

Below is a more detailed explanation for each of these files.

Note: The following information was written based on version 7.14
of the Smart3G firmware.

LEGEND
Description | General Information and notes on the file type.
Keyword The keyword syntax used to reference the file.
Index The available range of indexing values.
. The attributes that are present for the given file. The file type of the attribute is enclosed
Attributes | j, parentheses. Bit Indexing returns a bit using a specified bit position (Known as BIN in
SuperlLogic).
Format The Format address syntax used to reference a specific file in the Ladder Program.
Italicized text enclosed in <> are variable values.
Usage How the file can be used (Read, Write, or both).
Integer Register
A 32-bit signed integer. Referred to plainly as “Register” in SuperLogic Pro.
Description
Keyword REG
REV A SuperLogic Pro - User & Troubleshooting Guide
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Index e 1to50

Attributes | it |ndexing [0 - 31]

Format REG:<file index>.<bit index>

Usage Read, Write

Float Registers

Description A 32-bit signed floating-point value that can use fractional values following a decimal
point.

Keyword FLT

Index e 1t025
Attributes

Format FLT:<file index>
Usage Read, Write

Binary Registers

Description | A bt value that can be 0 or 1.

Keyword | g\

Index e 1to64
Attributes

Format BIN:<file index>
Usage Read, Write

REV A SuperLogic Pro - User & Troubleshooting Guide
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Timer Registers

Timers that can keep time in a resolution of milliseconds. The timer keeps time until the
user-defined preset value is reached.

Description
Keyword TMR
Index e 1to50
e AC- Accumulated Time in milliseconds (REG value).
e PR —Preset Value in milliseconds (REG value).
Attributes e EN - Timer Enabled (BIN value).
e DN - Done Timing (BIN value).
e TM — Currently Timing (BIN value).
Format TMR:<file index>.<attribute>
Usage Read

Counter Registers

REV A

Counters that increment their accumulated value by 1 every time the rung state
transitions to true. Directly usable only with the Reset and Counter Command.

Description
Keyword CNT
Index e 1to10
e AC- Accumulated Counts (REG value).
Attributes e PR —Preset Value (REG value).
e EN - Timer Enabled (BIN value).
e DN —Done Timing (BIN value).
Format CNT:<file index>.<attribute>
Usage Read

SuperLogic Pro - User & Troubleshooting Guide
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Inputs
Input states of the Smart3G Device (similar to BIN values in usage).
Description
Keyword IN
Index 1to 72
Attributes
Format IN:<filelndex>
Usage Read
Outputs
Output states of the Smart3G Device (similar to BIN values in usage).
Description
Keyword ouT
Index 1to0 72
Attributes
Format OUT:<file index>
Usage Read, Write

Control Words

Description | g,ccial purpose 16-bit integers for device control.
Keyword CW
Index 1to 85

REV A SuperLogic Pro - User & Troubleshooting Guide
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Attributes | gt |ndexing [0 - 15]

Format CW:<file index>.<attribute>

Index Use | Description

1-2 RW | Data is transmitted to master in Ethernet/IP poll. Can be used to
transmit status info to master.

3-4 Reserved
RW | Serial Port Baud Rate. Baud rate = (CW5value x 100).
Ex: Write 96, 144, 384 etc. for 9600, 14400, 38400 Baud

6 R Merge Device ID (Read Only)

7 Divert 1 Device ID (Read Only)

8 R Divert 2 Device ID (Read Only)

9-10 RW | Ethernet/IP or Modbus/TCP - Data Write from Master

11 RW | Local Device ID

12 RW | Downstream Device ID

13 RW | Upstream Device ID

14 R Master/Slave Protocol Scan List Status. Bits 0 =7 indicate online

status for each device. Bits 8 — 15 indicate Output Power Status.
15 R User Defined. This value is read from the SuperlLogic Zone Count
configuration parameter. (Read Only).
Usage 16 RW | Ladder Logic Transmit Message Destination Device ID

17-22 | RW | Ladder Logic Transmit Message Data. Each control word can have
a value of O thru 255.

23-24 RW | Special Definition for Modbus/TCP Holding Register
Read CW:23 = Read 8 Inputs (Bits 0 — 7) and new serial port data
bit (Bit 15)
Read CW:24 = Read 8 Outputs (Bit 0 — 7) and Output Enable Bit
(Bit 15)
Write CW:23 = Write to CW:23

Write CW:24 = Write to CW:24, or Write directly to output pins if
Remote 1/0 Checkbox is checked.

25-30 | RW | Ladder Logic Receive Message Data. Each control word can have
value of 0 to 255.

31-40 Reserved

41-48 | RW | Device IDs for remote (slave) Smart-3G controllers. Used to
enable slave device scanning for the S3G Master/Slave protocol.
Value of 0 disables scanning.

49-56 R Input/Output data for slave devices for S3G protocol. Bits 0 —7
are inputs and bits 8 — 15 are outputs. This data is also accessible
using the IN/OUT file, (e.g. IN:55, OUT:71 etc.)

REV A SuperLogic Pro - User & Troubleshooting Guide 3.5
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R Scanned barcode length
Reserved
R Received barcode text

Control Bits

Special purpose binary values for device control.

CcB

1to 25

CB:<file index>

Index | Use | Description
1 R ‘ Package Arriving from Merge Branch. (Input, Read Only)
2 RW | Merge Ready Status to Branch (Output, Read / Write)
3 RW  Package Available for Divert Branch 1. (Output, Read / Write)
4 R Divert Branch 1 is Ready (Input, Read Only)
5 RW  Package Available for Divert Branch 2. (Output, Read / Write)
6 R Divert Branch 2 is Ready (Input, Read Only)
7 R FIFO is Empty (Read Only)
8 R FIFO is FULL (Read Only)
9 R Output Power On (Read Only)
10 RW New Barcode Received (Read / Write)
Package Available Status to Downstream main line (Output, Read /
11 RW R
Write)
Ready to Take Packages from Upstream main line (Output, Read /
12 RW .
Write)
13 Reserved
General Purpose Configuration Bit. The value is set in the SuperLogic
14 R Configuration screen by the user and saved in Smart3G Flash
memory. (Read Only for Ladder program). This bit can be used for
any configuration selection the user may decide.
Barcode Overrun. This bit is true when a new barcode overwrites the
15 current barcode if CB:10 is on. This bit must be cleared manually by
the ladder program.
16 Reserved

REV A
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17 Reserved

18 R Package Available from Upstream main line. (Input, Read Only)

15 R Downstream main line is ready to take packages. (Input, Read Only)

Barcode
Received barcode text located on CW:61 - 81

Descriptio
[ omm e ot s e et oo ctvation, ]
Keyword BAR
Index

e Subtext. BAR:<start index>

» Returns all the barcode characters at the specified <start index>.
L] < i >, <l >
» Returns a number of barcode characters (specified by <length>) at the specified
<start index>.

Example: Current barcode is “1234567890".
Attributes BAR:0 will return “1234567890"

BAR:5 will return “67890”

BAR:0,5 will return “12345"

BAR:1,5 will return “23456”
Format BAR:<start index> or BAR<start index>,<length>
USES! Read

REV A SuperLogic Pro - User & Troubleshooting Guide
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A Ladder Program is comprised of multiple rungs that are executed from top to bottom.
Each rung is comprised of two types of commands, namely the inputs and outputs.

Input commands are used to evaluate if the state of the rung (active or not) which affects
the execution of the output commands.

Output commands are commands that carry out actions in the ladder program such as writing
to file values. Some output commands are not executed if the rung is inactive, while others
will simply behave in a different manner.

Normally Open Command
REG:0.10

Description | An input command whose condition is true when the addressed bit value is active.

Type Input

Parameters | Address — the referenced bit to read from. (Ex. IN:1, OUT:2, TMR:2.TM).

Usage Read

File Types | All Binary Types. (BIN, IN, OUT, CB, Register Bits, TMR/CNT Attributes, etc.)

Normally Closed Command

TMR:1.TM

Description | An input command whose condition is true when the addressed bit value is inactive.

Type Input

Parameters | Address — the referenced bit to read from (Ex. IN:1, OUT:2, TMR:2.TM).

File Types | A| Binary Types. (BIN, IN, OUT, CB, Register Bits, TMR/CNT Attributes, etc.)

REV A SuperLogic Pro - User & Troubleshooting Guide 4.1
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Compare Command

[Compare |

Argl REG:S

':ID

ArgZ REG:15

Description

A command whose condition depends on the logical comparison of the values of two
referenced files.

Type

Input

Parameters

e Argl — The first argument (referenced file or constant) for comparison. (Ex. 10,
REG:5, “text”, BAR:8,10).

e Arg2 - The second argument (referenced file or constant) for comparison. (Ex. 10,
REG:5, “text”, BAR:8,10).

e Operation — The logical comparison to make between the 2 arguments.
» Equal ( =) —true if the 2 arguments are equal.
» Not Equal( != ) — true if the 2 arguments are not equal.
» Greater Than ( > ) —true if Argl is greater than Arg2.
» Less Than ( <) —true if Argl is less than Arg2.
» Greater Than or Equal to ( >= ) — true if Argl is greater than or equal to Arg2.
» Less Than or Equal to ( <= ) —true if Argl is less than or equal to Arg2.

File Types

Numerical values (REG, FLT, CW). Text values (BAR, BAR:5, BAR:8,10). Timer .PR .AC and
Counter .PR, .AC Accumulators.

Examples

The Compare Command can also be used for received Barcode Comparisons, and on
Timer/Counter Accumulators like in the example below.

COMPARE COMPARE
Argl TMR:9.AC

Op
Arg2 2000

REV A
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Text (Barcode) Lookup Command

I BARCODE I

Checks if the current scanned barcode is defined in the selected “Text/Barcode
Database”.
Description
Type Input
e Lookup Target — The “Text/Barcode Database” where the lookup will be performed.
LT For more information on creating .the .barcode fiatabase, see Barco.de !_ookups. Once
the database has been created, it will show in the drop down list in the contact
properties.
File Types | Text/Barcode Database
REV A SuperLogic Pro - User & Troubleshooting Guide 4.3
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Output Command

This command sets the addressed bit to true or false. When the rung condition is true,
Description | t1e addressed bit or output is set to true (1 or high) and with rung condition false, the bit
or output is set to false (0 or low).

Type Output

¢ Address — the referenced bit value to write to (Ex. Out:1, REG:5.3, etc).
e Output Type — Controls the behavior of the command.

» Normal () — If the rung is active, it writes 1, otherwise it writes 0.

» Latch (L) - If the rung is active, it writes 1, otherwise it does nothing.

Parameters
» Unlatch (U ) — If the rung is active, it writes 0, otherwise it does nothing.

» Latch Transition to True( ™) — Writes 1 only when the current rung state becomes
active and the previous rung state was inactive.

» Latch Transition to False( v) — Writes 1 only when the current rung state becomes
inactive and the previous rung state was inactive.

File Types | ginary files (BIN, OUT, CB, Register Bits)

REV A SuperLogic Pro - User & Troubleshooting Guide
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Timer / Counter Command
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The Timer/Counter command makes use of either a Timer or Counter register for its
functionality

Description
e Timer — The timer register keeps timing until the preset value (in milliseconds) is
reached.
e Counter — The counter register keeps counting until the reset value is reached.
Type Output
e ID - The timer or counter register that is bound to this command.
e Preset — A 32-bit integer value that specifies when the command stops
timing/counting. For timers, this value is in milliseconds.
e Type - Controls the behavior of the command.
Parameters
Timer Types:

ON _DELAY - This timer starts timing when the rung condition
becomes true. As long as the rung condition is true, the accumulator
keeps on timing until it reaches the preset value. When the
Accumulator is equal to Preset, the ‘Done’ bit is set and the Timing
bit is reset. The Timer Enable bit follows the rung condition. The Done bit, Timing Bit
and Enable Bit are reset as soon as the rung condition becomes false. The Accumulator
is reset to 0 until the rung condition becomes true again.

REV A
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| Rung State
| Enable Bit

| Timing Bit

| | Done Bit

L L

Time

ON Delay Timing Diagram

OFF_DELAY - This timer starts timing when the rung condition
transitions to false. When the rung state transitions from true to false,
the Accumulator keeps incrementing until the preset value is reached
or the rung condition becomes true again. The enable bit follows the
rung state, while the Done bit is a combination (logical ‘OR’) of the Enable and Timing
bits. The Timing and Done bits are reset when the Accumulator reaches the Preset value.

| Rung State
| Enable Bit

I Timing Bit
Done Bit

Time

OFF Delay Timing Diagram

Counter Types:

UP_COUNT - The “UP Counter” counts every rung state transition
from false to true until the Preset value is reached. Each transition of
rung condition from false to true is registered by incrementing the
Accumulator by 1. When the Accumulator value becomes equal to
the Preset value, the Done bit is set to true. The Enable Bit follows the rung condition.
The “UP Counter” can only be reset with “Reset contact”. At reset, the Accumulator
value and the Done Bit are set to zero. Please refer to Timer/Counter Reset element.

File Types

TMR, CNT

SuperLogic Pro - User & Troubleshooting Guide
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Move Command

Source req:S
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Dest. reg:15
Mask

Description | Copies a specified source file’s value (or a constant numerical value) into a specified
destination file while the rung is active.
Type Output
e Source — The referenced file or constant value to be moved (Ex. 5000, 0.056, REG:9,
CW:10, etc).
Parameters
e Destination — The file where the source file’s value is written (Ex. FLT:2, REG:9,
CW:10, etc).
File Types | Numerical Values. (REG, FLT, CW)

Send Message Command

Sends a message over Ethernet to other card or PC Host.
e _
Type Output
» Smart3G — This protocol sends an explicit message to another Smart3G Device,
or to the host. When the rung condition becomes true, the 6 bytes of data in the
send-buffer will be sent to the receive buffer of the destination device. The send
Parameters and receive buffers can only hold values from 0 to 255 in each location.
Send Buffer CW:17 - CW:22
Receive Buffer | CW:25 - CW:30
Destination CW:16
REV A SuperLogic Pro - User & Troubleshooting Guide 4.7
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Math Command

Performs binary and unary mathematical operations (depending on how many
arguments were specified) and writes the result to a specified destination file while the

rung is active.
Description
Type Output
e Argl-— The first argument. (Ex. FLT:4, 5000, 4.556, REG:9, CW:10, etc)
e Arg2 - The second argument. (Ex. FLT:4, 5000, 4.556, REG:9, CW:10, etc)
* Destination — Address of File to store the result. (Ex. FLT:4, REG:9, CW:10, etc)
* Binary Operation — operation to perform between the two arguments. All Bit
manipulation values must be done with REG (integer) values.
» None - the result is the value of Argl. Arg2 is ignored.
» Addition
» Subtraction
» Multiplication
Parameters » Division

» Power/Exponentiation

» BitAND - Bitwise AND

» BitOR - Bitwise OR

» BitXOR — Bitwise Exclusive OR

» BitShiftLeft — Shifts Argl’s bit value by a specified number of digits (Arg2’s
value) to the left.

» BitShiftRight — Shifts Argl’s bit value by a specified number of digits (Arg2’s
value) to the right.

* Unary Operation — operation to perform on the result of the Binary Operation.
» None
7 Negative — Negates the value.
» Bitwise Inversion — Invert the bit value.
» Absolute — Absolute value.
» Square Root

Sine
Cosine
Tangent
Cosecant
Secant
Cotangent

YV V.V V V V V¥V

Natural Logarithm
» Common Logarithm

File Types | Numerical Types. (REG, FLT, CW)
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Reset Command

Reset TMR:0

Resets a timer or counter when the rung becomes active and the previous state was
Description inactive.

Type Output
Parameters e Address — The Timer or Counter to reset. (Ex. TMR:20, CNT:10 etc)
File Types TMR, CNT

Ladder Subroutine Command

I LADDER SUB I

Ldr Accum

Creates a subroutine call using a Ladder Subroutine from the project. For more
Description | i formation on Subroutines, refer to What are Ladder Subroutines and how do | use
them?

Type Output

e Call Name — The unique name for this instance
Parameters

e Ladder Subroutine — The Ladder Subroutine to be used.

File Types | Ladder Subroutine
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Creating your First Ladder Program

1 Click File, then New Project. You should then see the screen below

REV A SuperLogic Pro - User & Troubleshooting Guide
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2 You may now start editing your new Ladder Program. You can create the first rung,
as well as add contacts from the Toolbox Window (Accessible from the View Toolbox
Menu circled in red). Click on the Thumb-pin of the Toolbox window to make it visible

all the time
i’ -—
} Poew  Jook  Bewnd pote
el frr.'| WA - Mdaym " B
bt b iw L

3 You may give the project a name when you save it. From the Menu Bar,
click File -> SaveAs
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Importing a (.prg) Ladder Program

Instead of creating a ladder program from scratch, SuperlLogic Pro can also import
older Ladder Logic programs (.prg files). This can be done the same way as opening
any ladder project.

1 On the main menu, click File -> Open Project
/', Superlogic Pro : burnin

File | View Tools Smart3G
New LogicON Project

Recent Projects »

Open Workspace
Open Project

Save Project
Save Project As

Close Project

Close File

Exit

2 Select a (.prg) ladder program to open

'\ Oper [[— '
- < » dev b LogicOn Projects - Search LogicOn Projects )
Organize » New folder = » [ @

& Favorites *  Name Date modified Type *
B Desktop FX Transfer v3.ldr 3/6/2015 1:43 PM LDR
‘| Recent Places = ,’\ uploadTest.ldr 3/6/2015 2:14 PM LDR
& Music | 4ZoneAccum.prg Micr
|. Magic Briefcase 5 9 192.168.0.19-82-83 Transfer v3.prg Micr
dev 3 Round Robin Lane Assignment.prg Mic
J Work (F22) - Short: [ test.prg Micr
Skype Downloads 3 Tracking_Accumulation_8zone_Max.prg 6/11/201512:33 PM  Micr
& Downloads 3 Transfer v3.prg 3/5/201512:41PM  Micr|
sales | transfer.prg 1/12/201212:43 PM  Micr
3 TST2.PRG 6/11/201510:49 AM Micr «
= |ihrariec il 5.5 m »
File name: test.prg v [Ladder Projects(*.ldr;".prg) - I
| [ Open I'J [ Cancel J
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3 Imported (.prg) programs will most probably require a few conversions,
some of which are performed automatically
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Runtime Operation
Although SuperlLogic Pro can compile o _ =
Ladder-Logic programs, running them g LE Py ::J ‘t Cl @@j ol
' tion t t Device. 3
requires a connection to a Smart3G Device T, son SEkings | E

Click the Connect Button (circled in red)
to setup a connection. A window with Adapter P l 192.168.0.213 - |
Connection Parameters will appear.
Set the necessary values for the specified Device ID 65 v
fields then click on “Connect”.

network the Smart3G device is located. LComect J | Cancel ]
This setting can be changed for PCs
with more than one network adapter.

Poll Freq 100
The Adapter IP entry defines on which

The Device ID entry determines which Smart3G device SuperlLogic Pro will connect to.

Poll Frequency determines the interval (in milliseconds) to request monitoring data
from the Smart3G device.

Note: Before attempting a connection, make sure that the Smart3G device is connected
to the network and is not in an error state (such as conflicting IP Address).

Download

If the connection attempt is successful, you are given the option to then “Download”
your current project on the Smart3G Device, or “Upload” the running project
from the Smart3G device.

e Download - Installs the current project on the Smart3G device. After downloading
the project, the ladder program can then be started by clicking on the “Run Ladder
Program” button. Additionally, the Smart3G device will now always run the ladder
program on power-up.

e Upload - Retrieve the project from the Smart3G device
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Barcode Lookups

Note: Make sure the Barcode scanner is set to Baudrate=38400, DataBits=8, Parity=None,
StopBits=1, and CR or LF is sent at the end of the barcode string. Host ID in the 3G config
should be set to None in order to use the on-board lookup feature. The Baudrate on the
3G card can be modified by writing the Baud value divided by 100 to CW:5, e.g., for 9600
baud, write 96 to CW:5. Other port settings are fixed at 8 bits, No Parity, 1 Stop Bit.

1 Barcode Lookups first require a barcode table where the lookup can be performed.
To do this, go to the Project Explorer and right-click the “Barcode Database”
and select Add

|ProjectBxplorer 1 X

=-__| “Wew LogicON Project
: __| Ladder Programs
[E newLadderProgram
___| Subroutine Templates
0 Tag Dictionary

-
Add

2 Enter a name for the new barcode table then click OK to create
the new barcode table

[ Add New Bascode Tabile

Barcode Table 7
L.
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3 A new entry should appear under the Barcode Database for the new barcode table.
Double-click it to open the new barcode table. Barcodes can be added and removed
from here. Once the barcode table has all the necessary entries, it can now be used
within the ladder program

m— 2 X[ *BarcodeTablel 2 |8
| Name
| Mew LogicON Project 1234567890
-J-___| Ladder Programs » 1122334455

@ newlLadderProgram
___| Subroutine Templates
0 Tag Dictionary
--@lj Barcode Database

Note: Even though SuperLogic allows creating multiple barcode tables, only one
Barcode Table can be searched by default. The “Extended Barcode Table Lookup”
feature is required for using multiple barcode tables in the Smart3G device.

Please Contact www.vsys.co to purchase the Extended Barcode Feature Activation.

4 To use the new barcode table, it will need to be referenced by a “Lookup Contact”.
Add a Lookup Contact in the ladder program (from the toolbox)

B Ladder Subeoutne

¢ rewt Ruryg Beiow

T inset Rung Erarch

Note: It’s always recommended to unlatch CB:10 in order to allow the 3G card to
receive new barcodes. If CB:10 is left ON, then the Smart3G device will NOT receive
any new barcode data.
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5 Click on the new Lookup Contact and check its properties from the Properties
Window. The Lookup Contact requires a LookupTarget, which is any barcode table
from the current project, where the lookup will be performed. A Start Index
and Length may also be specified if only a part of the barcode string is required

to perform the lookup

Examples:

BarcodeTablel m"/\l

LookupTarget BarcodeTable1

-1
Length -1
4 Misc
Comment
Enabled True
Start Index

The subtext start index.

This example will check if the current
barcode is defined as an entry
in “BarcodeTable1”.

BarcodeTablel |:: } 1

4 Command: Lookup
LookupTarget BarcodeTable1
StartIndex 4

Length 4
4 Misc

Comment

Enabled True
Length

The sub4text length

Lookup Target BarcodeTable1

4
Length -1
4 Misc
Comment
Enabled True
Start Index

The sub+ext start index

This example will check if all the
remaining characters, after the
4th character of the barcode
string is a text entry defined in
“BarcodeTable1”.

This example will check if the next 4
characters, after the 4th character
of the barcode string, is a text entry
defined in “BarcodeTable1”.
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6 \Whenever a scanned barcode is present in the Smart3G device, the lookup contact

will check the barcode table and see if the scanned barcode is contained within.
If the scanned barcode is defined inside the barcode table, then the contact’s state

becomes true, and false if not. Multiple barcode tables can be utilized in order
to perform certain functions depending on the scanned barcode.

(&) I

BarcodeTablel oUT:1

PN = \R CODE

BarcodeTable2

2  EEREEE

BarcodeTable3 ouT:3

S - R.CODE S — )

It's always recommended tp unlatch CB:10in orderto allowthe 3G card to receive new barcodes. If CB:10is left ON, then the Smart3G device will NOTreceive
any new barcode data

CB:10

I BarcodeTablel X BarcodeTable2

Name

1111000
1111000

Note: When using serial scanners (e.g. barcode scanning), CB:10 must be
unlatched in order to receive new serial data. Failure to unlatch CB:10 will result
in new serial data being ignored by the 3G Device.

REV A SuperLogic Pro - User & Troubleshooting Guide
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Barcode Comparison
Specific regions of text in the barcode string can be checked via the compare command.
See Barcode file type.

Note: This feature requires the “Extended Lookup?” activation and will defult
to FALSE if CB:10 is NOT ACTIVATED.

4 |
4 Command: Compare
Arg1 BAR-0.2
Argl BAR:0,2 Operation -
Op = A7 "
Arg2 "1Z" g el
IgnoreCase True
4 Misc
Comment
Enabled True
Amgl
First Argument
TMR:2.DN

A

BAR:0,2 indicates that the first 2 characters of the barcode string are what will be

used for the compare operation. Therefore, if a barcode which begins with “1Z”, or “12”
(because IgnoreCase has been set to true) is received, then the compare contact

will evaluate to an active state.
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What do enabled/disabled rungs and contacts do?
By default, all rungs and contacts are enabled for the ladder program.
This means that they are included in the ladder code compilation.

This is a disabled rung

1

[=:1

This is a rung with some contacts disabled 4 Command: Normally Open

Address BIN:3
AT = TN =D
E'Lri-l E‘LTJ._ a “m

5 H }— —{ }— Comment Disabled Contact
 Ena 7-'7 '7' - ?'_

The “Enabled” setting for a contact or rung can be toggled from the Property Window.
Setting “Enabled” to false disables the contact.

Setting a contact as disabled tells the compiler to ignore this contact and exclude it from the
compiled ladder program. Disabled input contacts are treated as short contacts while disabled
outputs are ignored. Disabled rungs, on the other hand, tell the compiler to ignore every
contact regardless if the contacts themselves are enabled.

This feature comes in handy if you wish to temporarily exclude (without deleting the
rung or contact itself) certain elements of the ladder program for debugging purposes.
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What are Ladder Subroutines and how do | use them?

A Ladder Subroutine is a type of Ladder Program that only needs to be created once

and can be used multiple times in a Ladder Program as well as in multiple Ladder Programs.
The use of subroutines can greatly minimize programming time due to the use of generic code.

Unlike normal ladder programs, subroutines cannot be directly executed, but rather, they are
executed from within a true ladder program. Subroutines have access to all registers and files
as the main program.

To use a Ladder Subroutine in an existing Ladder Program, you must first create the Ladder
Subroutine Template.

1 Right Click on the “Subroutine Templates” folder in the Project Explorer
and select “Add New”

/\ Superlogic Pro

File View Tools Smart3G Help

J0E GASKOS A0

=}-__] 4ZoneAccum
= ___| Ladder Programs
* IE 4ZoneAccum
S | Subroutine Temolate:

2 Enter the name for your new Subroutine and click OK

e s D &

<new ladder documert>

L 0K J[ Concel |
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3 After creating your Subroutine Template, you may now create a subroutine
instance from within an existing ladder program. This can be done by adding
a ladder subroutine command (from the Toolbox)

Input Contacts
<4k NO Contact
2\E NC Contact

%? Compare

Output Contacts
) Output
Timer/Counter
I Move
£ Send Message

B8 math

RS Resst

4 Select the new contact and view its properties. Give your new subroutine
instance a new Call Name (this value must be unique across the entire project)
in the CallName property. In the LadderSubroutine property, you should
see a drop down list of all your Ladder Subroutine Templates.

Select the one you wish to use

d=-1A
(D2

Ldr subroutine 4 Command: Ladder Subroutine
CallName subCall1 _

4 Misc
Comment
Enabled

LadderSubroutine

The Ladder Subroutine Template for this
Instance

5 You can make any number of subroutine instances in your Main Ladder
Program now. Any changes you make to the Ladder Subroutine Template
will reflect on all its instances
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If you need further assistance:

Website:
www.poweredbyTrew.com

Email:
info@trewautomation.com

Phone:

1.800.571.8739
Monday - Friday, 8:00am - 5:00pm CT
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